Notices


No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Manual Part Number

G1115-90009

Edition

11/16

Agilent Technologies, Australia (M) Pty Ltd
679 Springvale Road
Mulgrave, Victoria, Australia 3170
www.agilent.com

Research Use Only

This product may be used as a component of an in vitro diagnostic system if the system is registered with the appropriate authorities and complies with the relevant regulations. Otherwise, it is intended only for general laboratory use.

Software Revision

This handbook is for B.05.xx revisions of the Agilent ChemStation software, where xx is a number from 00 through 99 and refers to minor revisions of the software that do not affect the technical accuracy of this handbook.

Warranty

The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered and licensed as “Commercial computer software” as defined in FAR 52.227-7014 (June 1995), or as a “commercial item” as defined in FAR 2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.

Microsoft is a U.S. registered trademark of Microsoft Corporation.
In This Guide...

This handbook describes what you have to do to install your UV-Visible spectroscopy system. Most of the handbook deals with installing a complete system, that is, the spectrophotometer, computer and printer. However, in the second half of this handbook you will find additional information about installing accessories, accessory boards, configuration, and software installation.

1 Fast Installation

Use this chapter as an overview of the different actions you must perform to install your UV-Visible spectroscopy system. If you are an experienced user of analytical equipment from Agilent Technologies, this may be all you need. If you need more information, this chapter guides you to other relevant areas in this or another handbooks.

2 Installation and Start Up

Use this chapter if you need more detailed information about the installation process.

3 Good Measurement Practices

Use this chapter if you require information about general operating conditions to perform accurate and reliable measurements, for example, handling samples, solvents and cells.

4 Installing Accessories

This chapter describes how to install the simple mechanical and optical accessories that are available to expand the capabilities of your UV-Visible spectrophotometer.

5 Installing the UV-Visible Software

This chapter describes what your computer requires, and what you must do to install the software.
6 LAN Communication, Installation, Connection and Configuration

This chapter describes how to set up LAN communication between your Agilent ChemStation and your UV-Visible spectrophotometer.

A Safety Information

This chapter contains relevant safety information.
Contents

1 Fast Installation 9
   Installing Preconfigured Agilent Cary 8454 UV-Visible Systems 10
   Installing Non-Preconfigured Agilent Cary 8454 UV-Visible Spectrophotometer Systems 11
   Installing Software Only 13

2 Installation and Start Up 15
   Site Requirements for Your Spectrophotometer 17
      Power considerations 17
      Power cords 18
      Space 18
      Environment 19
   Unpacking Your Spectrophotometer 20
   Installing your UV-Visible Spectrophotometer 21
      Instrument overview 21
      Setting up the Spectrophotometer 24
   Installing Your Computer 26
      Setting up the computer 26
   Starting the Spectrophotometer 27
      Turning On 27
      Instrument Warm-up 29
   Starting the Agilent ChemStation Software 30
   Operational Checkout 30
3 Good Measurement Practices  31
   General Considerations  32
      Spectrophotometer Design  32
      Making Measurements  32
      Sample Cell or Cuvette Material  33
      Optical Specifications of Cells  34
      Apertured Cells or Cuvettes  35
      Flow Cells  36
      Handling and Maintaining Cells or Cuvettes  37
      Solvents  39
      Sample Preparation  40
      Photosensitive Samples  41
      Stirring and Temperature Control  41
      Checklist for Best Results  42
   Inserting a Cell  44

4 Installing Accessories  45
   Thermostattable Cell Holder  46
      Installing a Thermostattable Cell Holder  47
   Cell Stirring Module  48
      Installing the Cell Stirring Module  49
      Tubing Connections and Operation  50
   Long Path Cell Holder  52
      Installing the Long Path Cell Holder  53
      Installing a Sample Cell  53
   Optical Filter Wheel  55
      Installing the Filter Wheel Assembly  57
      Removing the Filter Wheel Assembly  58

5 Installing the UV-Visible Software  59
   Agilent ChemStation Computer Details  60
Contents

Minimum PC Requirements for Agilent ChemStation 60
Installing the Agilent ChemStation Using the DVD 63
   Overview 63
   Uninstalling Pre-existing Agilent UV-Visible ChemStation Software 63
   Installation Procedure 64
   Configuring Your System 72

6 LAN Communication, Installation, Connection and Configuration 75
Installing and Configuring TCP/IP on the PC 76
   Installation of the TCP/IP protocol 76
Installing the LAN Interface in your UV-Visible Spectrophotometer 79
Connecting the Spectrophotometer to the PC 80
   Single Instrument Installation 80
   Multiple Instrument Installation 80
   Setting the IP Address of the Spectrophotometer 81
Using the Agilent BootP Service 82
   What is the Agilent BootP Service? 82
   Addresses 83
   Using the Agilent BootP Service Program 84
   Configure the Agilent BootP Service Program 85
   Configure the Agilent BootP Service 87
   Configuring the G1369C LAN Card Using BootP 89
Using the Agilent ChemStation Configuration Editor to Configure the
   Spectrophotometer 91
   What is the Agilent ChemStation Configuration Editor? 91
   Configuring an Agilent Cary 8454 UV-Visible Spectrophotometer 92
Troubleshooting LAN Communication 94
   Power failure reported on the Agilent ChemStation 94
   Frequent buffer overrun in Agilent Cary 8454 logbook 95
Contents

A Safety Information 97
  Protective Earth 97
  Disconnecting Device 97
  UV Light Source 98
  Equipment Class 98
  Installation category 98
  Pollution level 98

Index 99
1 Fast Installation

Installing Preconfigured Agilent Cary 8454 UV-Visible Systems  10
Installing Non-Preconfigured Agilent Cary 8454 UV-Visible Spectrophotometer Systems  11
Installing Software Only  13

Installation is straightforward, but if you have difficulties, or need more information, references to detailed installation information are given.

Use this chapter if you are:
• installing a preconfigured UV-Visible spectroscopy system from Agilent (including spectrophotometer, computer and software),
• installing a UV-Visible spectroscopy system not purchased as a preconfigured system, or
• installing software only.
Installing Preconfigured Agilent Cary 8454 UV-Visible Systems

If you have purchased one of these systems, the software is pre-installed and preconfigured. You need only install and switch on the hardware.

✔ Ensure you have space and an appropriate power supply.
For more information, see “Site Requirements for Your Spectrophotometer” on page 17.

✔ Unpack the system—check for damage and contents against packing list.
For more information, see “Unpacking Your Spectrophotometer” on page 20.

✔ Install your UV-Visible spectrophotometer.
  • Connect line power to the rear.
  • Connect the waste tubing underneath the sample pan.
For more information, see “Installing your UV-Visible Spectrophotometer” on page 21.

✔ Install your computer and printer.
  • Connect the keyboard and mouse.
  • Connect the monitor to line power and to the computer.
  • Connect the printer to line power and to the computer.
  • Connect the computer to the spectrophotometer with the LAN cable.
For more information, see “Installing Your Computer” on page 26 and Chapter 6, “LAN Communication, Installation, Connection and Configuration”.

✔ Switch on the spectrophotometer (make sure the sample area is clear), wait 2 minutes for the lamps to ignite. When you are ready to operate your spectrophotometer, switch on the computer and printer.
For more information, see “Starting the Spectrophotometer” on page 27.
Installing Non-Preconfigured Agilent Cary 8454 UV-Visible Spectrophotometer Systems

You must install and configure the software.

✔ Ensure you have space and an appropriate power supply.
  For more information, see “Site Requirements for Your Spectrophotometer” on page 17.

✔ Unpack the system - check for damage and contents against packing list.
  For more information, see “Unpacking Your Spectrophotometer” on page 20.

✔ Install your UV-Visible spectrophotometer.
  • Connect the line power to the rear.
  • Connect the waste tubing underneath the sample pan.
  For more information, see “Installing your UV-Visible Spectrophotometer” on page 21.

✔ If your computer and printer are not supplied by Agilent, ensure that the requirements for proper operation of the software are met.
  For more information, see “Minimum PC Requirements for Agilent ChemStation” on page 60.

✔ Connect the computer to the spectrophotometer with the LAN cable.
  For more information, see “Installing Your Computer” on page 26 and “LAN Communication, Installation, Connection and Configuration” on page 75.

✔ Install your computer and printer.
  • Connect the keyboard and mouse.
  • Connect the monitor to the power supply and to the computer.
  • Connect the printer to the power supply and to the computer.
  • Connect the computer to the spectrophotometer with the LAN cable.
  For more information, see “Installing Your Computer” on page 26.
**Fast Installation**

Installing Non-Preconfigured Agilent Cary 8454 UV-Visible Spectrophotometer Systems

✔ Switch on the spectrophotometer (make sure sample area is clear) and wait two minutes for the lamps to ignite. When you are ready to operate your spectrophotometer, switch on the computer and printer.

For more information, see “Starting the Spectrophotometer” on page 27.

✔ Install the Agilent ChemStation software.

For more information, see “Installing the Agilent ChemStation Using the DVD” on page 63.

✔ From the Windows Start menu, start the Agilent ChemStation software.

For more information, see “Starting the Agilent ChemStation Software” on page 30.

✔ Ensure that your software and spectrophotometer operate properly by taking a blank measurement or performing the automatic self-test in the diagnostic section of your software.

For more information, see “Operational Checkout” on page 30.

✔ If you need information about solvents, sample preparation, blank measurements, cuvette handling or how to insert a cuvette, see Chapter 3, “Good Measurement Practices”.

✔ Install any accessories.

For simple accessories see Chapter 4, “Installing Accessories”; for complex accessories, see the instructions supplied with the accessory or the Installation and Maintenance section of the Agilent ChemStation online help.
Installing Software Only

✔ Unpack the software—check for damage and check the contents against the packing list.

✔ Ensure that your computer and printer meet the requirements for proper operation of the software.

    For more information, see “Minimum PC Requirements for Agilent ChemStation” on page 60.

✔ Switch on the spectrophotometer (make sure the sample area is clear) and wait two minutes for the lamps to ignite. When you are ready to operate your spectrophotometer switch on the computer and printer.

✔ From the Windows menu install the Agilent ChemStation software.

    For more information, see “Installing the Agilent ChemStation Using the DVD” on page 63.

✔ From the Windows Start menu start the Agilent ChemStation software.

    For more information, see “Starting the Agilent ChemStation Software” on page 30.

✔ Ensure that your software and spectrophotometer operate properly, by taking a blank measurement or by performing the automatic self-test in the diagnostic section of your software.

    For more information, see “Operational Checkout” on page 30.
1 Fast Installation
Installing Software Only
2

Installation and Start Up

Site Requirements for Your Spectrophotometer 17
Unpacking Your Spectrophotometer 20
Installing your UV-Visible Spectrophotometer 21
Installing Your Computer 26
Starting the Spectrophotometer 27
Starting the Agilent ChemStation Software 30
Operational Checkout 30

The following topics are covered in this section:

• “Site Requirements for Your Spectrophotometer” on page 17 contains information about electrical requirements such as power lines, power cords, etc. It also gives recommendation for minimum available bench space and environmental conditions in the laboratory.

• “Unpacking Your Spectrophotometer” on page 20 contains information about what to do when the packing material is damaged or the shipment is incomplete. It includes a list of the items which are supplied with the instrument and computer.

• “Installing your UV-Visible Spectrophotometer” on page 21 gives an overview of the instrument and explains buttons, indicators and the line power switch. It explains where and how to connect line power, communications and waste drain tubing.

• “Installing Your Computer” on page 26 describes how to install the computer and peripherals, e.g. monitor, mouse, keyboard and printer.

• “Starting the Spectrophotometer” on page 27 describes the turn-on procedure for the spectrophotometer and the warm up time required to fulfill all specifications.
2 Installation and Start Up

- “Starting the Agilent ChemStation Software” on page 30 describes how you start your Agilent ChemStation software.
- “Operational Checkout” on page 30—use this section to ensure that your spectrophotometer, computer and the UV-Visible operating software is in proper operating condition. There is an optional automated self-test which can be used for a quick check of the spectrophotometer. This self-test can only be executed after the instrument has warmed up for at least one hour.
Site Requirements for Your Spectrophotometer

Power considerations

Your spectrophotometer can operate on a line voltage of 100–240 V AC with a line frequency of 50 or 60 Hz. Maximum power consumption is 220 VA.

The instrument power supply accepts any line voltage supplied in the above mentioned range. Consequently there is no voltage selector in the rear of the spectrophotometer. There are no externally accessible fuses, because automatic electronic fuses are implemented in the power supply.

WARNING

To disconnect the instrument from line power, disconnect the power cord from the supply. The power supply still uses some power, even if the power switch on the front panel is turned off.

The computer and InkJet or LaserJet printers accept a nominal line voltage of 110 or 220 V AC with a line frequency of 50 or 60 Hz. For more information, see the documentation that comes with your computer and/or printer.

WARNING

Connecting your instrument to a line voltage that is higher than specified causes a shock hazard, and damage may occur to your instrument.
Installation and Start Up

Site Requirements for Your Spectrophotometer

**Power cords**

Different power cords are offered as options with the spectrophotometer. The female end of each of the power cords is identical. This connects to the power-input socket at the rear of the spectrophotometer. The male end of each of the power cords is different and designed to match the wall socket of a particular country or region.

Do not replace the mains power cord with one that is inadequately rated. When replacing the mains power cord, use only a mains power cord with a rating equivalent to the one supplied with the instrument. See the instrument installation guide for detailed mains power cord rating information.

---

**NOTE**

Always operate your instrument from a power outlet which has a ground connection. Always use the power cord designed for your region.

---

Do not position the equipment so that it is difficult to operate the disconnecting device.

**Space**

The spectrophotometer is 34.4 cm (13.5 inches) wide, 56.0 cm (22.0 inches) deep and 18.5 cm (7.3 inches) high (see Figure 1 on page 22). It weighs 14 kg (30.86 lbs) and will fit on almost any desk or laboratory bench. It needs an additional 2.5 cm (1.0 inches) of space on either side to allow for the circulation of air for cooling, and approximately 8 cm (3.1 inches) in the rear for electrical connections.

The computer, including the keyboard, is approximately 50 cm (19.7 inches) wide and 60 cm (23.6 inches) deep.

Additional space is required for accessories like pumps and autosamplers.
## Environment

### Table 1  Suitable environmental conditions for the 8454 UV-Vis

<table>
<thead>
<tr>
<th>Condition</th>
<th>Altitude</th>
<th>Temperature</th>
<th>Humidity (%RH)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-operating (Storage or shipping)</td>
<td>Up to 4,600 m (14,950 ft.)</td>
<td>-40 and 70 °C (-4 to 158 °F)</td>
<td>90% non-condensing</td>
</tr>
<tr>
<td>Operating within specifications</td>
<td>Up to 2,000 m (6,500 ft.)</td>
<td>5-40 °C (41-104 °F)</td>
<td>&lt;95%</td>
</tr>
</tbody>
</table>

**NOTE**
For optimum analytical performance, it is recommended that the ambient temperature of the laboratory be between 20-25 °C and be held +/- 2 °C throughout the entire working day.

**WARNING**
If you use the instrument at environmental temperatures higher than 50°C (122°F), the rear of the instrument may get hot.

**CAUTION**
Do not store, ship or use your instrument under conditions where temperature fluctuations could cause condensation within the instrument. Condensation will damage the electronics. If your instrument was shipped in cold weather, leave it in its box and allow it to warm up slowly to room temperature to avoid condensation.

Avoid air circulation of varying temperatures (like from refrigerators or air conditioners) and exposure to direct sun light to ensure the instrument operates within performance specifications.
Unpacking Your Spectrophotometer

Upon receipt of your spectrophotometer, computer and printer, inspect the shipping containers for any signs of damage. If the containers or cushioning material are damaged, save them until the contents have been checked for completeness and the spectrophotometer, computer or printer have been mechanically and electrically checked. If the shipping container or cushioning material is damaged, notify the carrier as well as Agilent Technologies. Save the shipping material for the carrier's inspection.

Check the contents of the shipping container against the list below. If any items are missing or obviously damaged, call Agilent Technologies.

**WARNING**

To avoid injury to personnel or damage to equipment, always use a two or more people or suitable lifting device when moving the instrument.

✔ Unpack the spectrophotometer. You should have the following components:
  - Power cord to connect the spectrophotometer to line power.
  - LAN Interface, if you connect the spectrophotometer through a LAN
  - Waste tubing to connect the sample pan of your spectrophotometer to a waste container.
  - Checkout sample (caffeine solution).

✔ Unpack the computer and its accessories. You should have the following components:
  - Computer and power cable
  - Keyboard
  - Mouse
  - Display unit, connecting cable and power cable
  - Printer, connecting cable and power cable
  - Printer accessories, for example, ink cartridge in case of a DeskJet printer
Installing your UV-Visible Spectrophotometer

Your spectrophotometer is very easy to install. This section provides an overview of the instrument and a checklist of the main installation procedure. If you have accessories for the spectrophotometer which are not covered in this section, see Chapter 4, “Installing Accessories” or refer to the documentation that was delivered with your accessories for detailed information.

Instrument overview

The front view of the spectrophotometer is shown in Figure 1 which shows the sample compartment open. Unlike conventional instruments the UV-Visible spectrophotometer does not suffer from ambient stray light. The open sample area makes it easier to access it generally and to connect tubing to a flow cell or thermostattable cell holder. The spectrophotometer is shipped with the standard single-cell cell holder already in place. Standard and accessory cell holders can be removed and replaced in seconds with few or no tools.
2 Installation and Start Up

Installing your UV-Visible Spectrophotometer

The line power switch is located at the lower left part of the instrument. Pressing it in turns on the instrument. It stays pressed in and shows a green light when the instrument is turned on. When the line power switch stands out and the green light is off, the instrument is turned off.

On the front panel of the spectrophotometer is an indicator which will display different colors depending on the actual condition of the instrument.

- Green: the instrument is ready to measure.
- Green, blinking: the instrument is measuring.
- Yellow: the instrument is in busy state, for example, turning one of the lamps on or if both lamps are switched off.
- Red: Error condition, that is, the spectrophotometer does not pass one of the self tests which are run when the spectrophotometer is turned on or an error occurred during operation. In this case the UV-Visible operating software gives a detailed error message and possible explanations are in the online help system. Additionally the Reference Manual gives information about troubleshooting.

Figure 1 Front view of the Agilent Cary 8454 UV-Visible spectrophotometer
• Red, blinking: Error condition of the spectrophotometer processor system. Because in this case there is no communication with the computer there will be no error message. The online help system and the Reference Manual gives more information about troubleshooting.

The four pushbuttons on the front panel cause the following actions to be performed and the resulting data being sent to the computer.

• blank: the instrument takes a blank measurement, that is, a reference measurement of solvent without the analyte. This is used in all subsequent sample measurements until a new blank measurement is taken. A baseline spectrum is displayed on the computer.

• sample: the instrument takes a sample measurement or starts a series of measurements. This depends on the parameters set in your software.

• standard: the instrument takes a measurement of a standard. Additional information, such as concentration and so on, have to be entered in the operating software.

• stop: the instrument and/or software aborts any ongoing activity and returns to a to measure state.

All connections are made at the rear of the spectrophotometer, see Figure 2.

![Rear view of the Agilent Cary 8454 UV-Visible spectrophotometer](image)

**Figure 2** Rear view of the Agilent Cary 8454 UV-Visible spectrophotometer
Installation and Start Up
Installing your UV-Visible Spectrophotometer

• The multi-cell connector allows you to connect the cable which comes from the multicell transport.

• The GPIO (general purpose input/output) connector allow you to connect your sipper and autosampler or other accessories.

• The remote connector may be used in combination with other analytical instruments from Agilent Technologies if you want to use features such as common shut down, prepare etc.

• The RS 232 connector may be used to control the spectrophotometer from a computer through RS 232 connection, using appropriate software (for future use). This connector needs to be activated by the configuration switch module next to the GPIB connector. The software needs the appropriate drivers to support this communication. See your software documentation for further information.

• The MIO slot for the Lan interface.

• The accessory board slot is reserved for future use.

• The power input socket accepts a line voltage of 100–240 V AC with a line frequency of 50 or 60 Hz. Maximum power consumption is 220 VA. There is no voltage selector on your spectrophotometer because the power supply has wide ranging capability. There are no externally accessible fuses, because automatic electronic fuses are implemented in the power supply. The security lever at the power input socket prevents that the spectrophotometer cover is taken off when line power is still connected.

On the right side of the instrument there is a door for exchanging the lamps. Behind this plastic door there is another sheet metal door. Two independent safety light switches are implemented. They automatically turn off the lamps when the sheet metal door is opened.

Setting up the Spectrophotometer

Connecting your Spectrophotometer via LAN to the Computer see Chapter 6, “LAN Communication, Installation, Connection and Configuration”

Connecting Power to Your Spectrophotometer

See Figure 2 on page 23.
1 Your line voltage must be between 100–240 V AC with a line frequency of 50 or 60 Hz. There is no voltage selector on your spectrophotometer because the power supply has automatic wide ranging capability.

2 Make sure the power switch of the spectrophotometer is in the off position, that is, the pushbutton stands out and the LED inside the switch is off, see Figure 1.

3 Plug the female end of the power cord into the power input socket at the rear of the spectrophotometer. Plug the male end of the power cord into your electrical outlet.

**Installing the Waste Tubing**

There is a waste outlet for the sample area. It is used to drain any liquids which may come from the sample area in case of a leak or a spill to a waste container. To connect your waste tubing to the spectrophotometer:

1 Lift the front part of the spectrophotometer up so that you can locate the waste outlet underneath the sample pan.

2 Connect the waste tubing which comes with your spectrophotometer to the waste outlet underneath the sample pan.

3 Put the other end of the waste tubing into the waste container.

4 Make sure that the waste tubing has a constant down slope from the spectrophotometer to the waste container.
Installing Your Computer

Detailed instructions for installing your computer are specific to the type and configuration of the computer and are provided with it. This section gives a checklist of the main installation procedures; refer to the documentation that was delivered with your computer for detailed information.

Setting up the computer

✔ If you have any additional accessories, install them before you set up your computer:
  • Additional memory, refer to your computer documentation.
  • Additional mass storage devices (hard disk drive, tape drive, DVD), refer to your computer documentation.
  • Accessory boards excluding USB to GPIB interface, refer to your computer documentation.

✔ Connect the keyboard and mouse to the sockets at the back of the computer.
  Locate the PC keyboard and mouse for ergonomically correct access.

✔ Connect the display unit to the video socket at the back of the computer.

✔ Connect the printer cable to the socket on the printer and to the correct printer interface socket on the back of the computer.

✔ Connect your LAN cable from the spectrophotometer to the LAN connector on the computer.
  For correct setup, see Chapter 6, “LAN Communication, Installation, Connection and Configuration”.

✔ Connect the power sockets to the computer, display and printer, and switch them on. Follow the instructions for setting up the computer in your computer documentation.
Starting the Spectrophotometer

Before you turn on your spectrophotometer, make sure the light path through the sample compartment is clear. All filters should be removed from the light path. Anything blocking or absorbing part of the light beam could cause an error indication when you turn on the spectrophotometer.

The power switch is located at the left front of the spectrophotometer. When starting UV-Visible application software wait until the completion of the self-test procedures for the spectrophotometer. Otherwise the application software may not recognize the spectrophotometer.

Turning On

1. Turn on your spectrophotometer with the pushbutton at the lower left part of the instrument. The pushbutton will stay pressed in and light green if power is present.

![Figure 4](image_url)

*Figure 4*  Turning on the Agilent Cary 8454 UV-Visible spectrophotometer
2 The fan will start turning.

3 The indicator at the upper left corner of the front panel will light in three different colors. The yellow color which means busy will stay on during the start up and self test routines, until at least one of the lamps are ignited and the spectrophotometer is ready to operate.

4 The turn on procedure, including electronic self tests, lasts about 20 seconds before the lamps start turning on. Under cold ambient conditions the lamp may not ignite and the instrument will repeat the ignition cycle automatically. The entire turn-on and self-test process will take about 1–2 minutes. Optical self tests are performed which last a few seconds.

5 When the green indicator at the upper left corner of the front panel comes on, the instrument is ready to measure and you can turn on your computer and printer.

If the software is set to leave both lamps off at turn on of the spectrophotometer, the front panel indicator remains yellow.

If the indicator shows a red color, there is an error condition. Try turning on the spectrophotometer again.

- red: error condition, that is, the spectrophotometer does not pass one of the self-tests. In this case turn on your computer and start the UV-Visible operating software. The software will give a detailed error message and possible explanations are in the online help system. Additionally the Operator’s Manual gives information about troubleshooting.

- red, blinking: error condition of the spectrophotometer processor system. Because in this case there is no communication with the computer there will be no error message. The online help system and the Operator’s Manual gives more information about troubleshooting.
Instrument Warm-up

Technically, once your spectrophotometer has passed the self-tests it is ready to run samples. For best results you may want to let the spectrophotometer warm up for at least 1 hour. This time allows the optical system to stabilize and should result in better measurements. If the instrument was not stored at room temperature before it was turned on, allow more time for the instrument to stabilize.

In general, the life of your spectrophotometer will be increased by leaving it on all the time but switching off the lamps when the instrument is not in use. Lamp intensity of the deuterium lamp and lifetime of lamps decrease with use.
Starting the Agilent ChemStation Software

If the Agilent UV-Visible ChemStations icon is not visible on the Windows Desktop, open the Start menu and select Agilent UV-Visible ChemStations from the list of programs. A maximum of two sessions of an instrument can be started in parallel; the online session must be always the first launched session.

Two instrument icons are displayed for the Agilent UV-Visible ChemStations:

- Instrument Online starts the software in online mode (online means Agilent ChemStation is connecting to the configured spectrophotometer).
- Instrument Offline starts the software in offline mode (offline means Agilent ChemStation is not connecting to the configured spectrophotometer).

To start the software, click the Instrument Online or Instrument Offline icon in the Agilent ChemStations section.

Operational Checkout

Operational checkout is used to determine if the instrument is in proper operating condition in combination with your UV-Visible operating software.

1. Be sure to verify the successful completion of the turn-on self test of the spectrophotometer, that is, the indicator light on the front panel of the spectrophotometer is lit and is green.

2. In your UV-Visible operating software, take a blank measurement and observe the baseline noise. With an empty sample area, this should be in the low mAU range. Excessive noise or spikes may indicate a problem.

3. For the spectrophotometer an additional (optional) qualification can be automatically performed using your software. After warm-up of the spectrophotometer for one hour, the instrument is ready for the automated self-test which is located in the diagnostic portion of the software. The successful completion of these tests complete the operational qualification of your spectrophotometer. For reference purposes, you may want to print a copy of the results.
3 Good Measurement Practices

General Considerations  32
Inserting a Cell  44

This chapter describes:
• making measurements
• selecting material, optical specification and type of cell
• handling and maintaining cells
• checklist for good results
• solvents selection,
• sample preparation,
• use of filters,
• stirring and temperature control of sample,
• how to insert cuvettes into the cell holder.
General Considerations

There are many factors that can affect the results of your measurements. This section provides brief discussions of some of the more important ones.

Spectrophotometer Design

The sample compartment of the spectrophotometer is open. Unlike conventional instruments, the Agilent Cary 8454 UV-Visible spectrophotometer does not suffer from ambient false light. The open sample area is easier to access, and it is easier to connect tubing to a flow cell or thermostattable cell holder.

Making Measurements

Blank (Reference) and Sample Measurement

Your spectrophotometer is a single beam instrument so you must measure a blank before you measure a sample. For high accuracy measurements, the blank and the sample measurement should closely follow each other.

In general, a blank measurement should be repeated as often as is practical. Even in a thermally stable environment, a blank measurement should be taken every half hour to ensure accurate results.

Chemically, the only difference between the blank and the sample should be the presence of the analyte(s). For measurements with liquid samples, the blank should be a sample cell filled with the solvent you plan to use.
Sample Cell or Cuvette Material

Quartz sample cells (cuvettes) or sample cells with quartz face plates are required if you want to use the full 190 to 1100 nm wavelength range of your spectrophotometer.

If you plan on working only in the visible and/or short-wave near-infrared range of 350 to 1100 nm, you can use good quality glass cells.

Disposable plastic sample cells, for measurements in the range 400 - 1100 nm, are also available. The quality of these cells varies and they are generally not recommended.
Optical Specifications of Cells

The accuracy of the readings of a diode array instrument is very sensitive to spatial shifts of the analysis light beam. Cells having non parallel opposite faces, or so called wedge shaped cells, lead to a spatial shift of the light beam (see Figure 5). Therefore, the opposite cell walls illuminated by the analysis light beam have to be parallel. The degree of parallelism is measured in terms of the **angle between the two opposite cell walls**. We recommend that you use 10 mm path length cells with **an angle which is below 0.1 degrees of an arc**.

**Figure 5**  Shift of the instrument light beam due to non parallel cell walls
Apertured Cells or Cuvettes

In applications where sample volume is limited, *apertured* or microcells are used. The width of these cells is reduced to reduce the volume and the *blank part of the cell must be blackened* to avoid unwanted transmission and reflection through the side walls. If the side walls are not blackened the result will be poor photometric accuracy and, if different concentrations are measured, poor linearity.

The disadvantage of apertured and microcells is that part of the light beam is blocked. Not all the light passes through the sample and there can be some loss in sensitivity. See Figure 6 for recommended cells and Figure 7 for cells you should not use with the instrument.

![Figure 6](image)

**Figure 6**  Recommended cells

*Quartz cells with black apertures* smaller than 2 mm, when used with a multicell transport, can lead to measurements of poor reproducibility.
3  Good Measurement Practices
   General Considerations

Flow Cells

We recommend a sipper system with a flow cell for obtaining high precision measurements. Using a flow cell eliminates the necessity of moving the cell between blank measurement and sample measurement. Also, the cell can be rinsed thoroughly with the solution to be measured.

The design of the flow cell should minimize entrapment of bubbles and flow channeling to provide the most reliable results.
Handling and Maintaining Cells or Cuvettes

Passivating New Cells

When filling a non-passivated new cell with your sample, you will observe that air bubbles stick on the windows of your cell. To prevent the formation of sticky bubbles, rinse the cell with cleaning and passivating fluid (part number 5062-8529). The cleaning procedure is described on the label of the cleaning fluid container.

Cleaning Cells

The fats in fingerprints are significant absorbers in the UV region and, if left on optical surfaces, can cause erroneous results. Wipe off all fingerprints and contaminants before using a sample cell.

Use only high quality lens tissues (part number 9300-0761) and never dry the inside of a cell with lens tissues. Dry the inside of the cell with pressurized, oil free air, that prevents the cell from contamination by tissue particles, or rinse the cell with blank or sample solution. Floating particles in the cell will deflect the light beam and so lead to a very poor quality of the measured spectrum.

Figure 8 Floating particles in a cell
Good Measurement Practices

General Considerations

Lens tissues for glasses or other uses often contain detergents or lubricants which can affect your measurements. If possible avoid cleaning the faces of your cell between blank and sample measurements.

Handling Cells

Always install a cell so that it faces the same direction to minimize problems with cell non-uniformity. For best results with microcuvettes, leave your sample cell clamped in position throughout the measurement sequence. Solutions should be removed and replaced by pipette or use flow cells.

CAUTION

If glass pasteur pipettes are used, make sure that the optical windows of the cell are not touched or scratched by the pipette.
Solvents

Your choice of solvents should be based primarily on the solvent’s absorbance characteristics over the wavelengths of interest, its suitability as a solvent for the analyte, and on experimental conditions. Table 2 lists common solvents and the lower limit of their useful wavelength range.

Table 2  Lower limit of UV transmission for some common solvents

<table>
<thead>
<tr>
<th>Lower Limit</th>
<th>Solvent</th>
</tr>
</thead>
<tbody>
<tr>
<td>180–195 nm</td>
<td>Sulfuric acid (96%)</td>
</tr>
<tr>
<td></td>
<td>Water</td>
</tr>
<tr>
<td></td>
<td>Acetonitrile</td>
</tr>
<tr>
<td>200–210 nm</td>
<td>Cyclopentane</td>
</tr>
<tr>
<td></td>
<td>n-Hexane</td>
</tr>
<tr>
<td></td>
<td>Glycerol</td>
</tr>
<tr>
<td></td>
<td>2,2,4-Trimethylpentane</td>
</tr>
<tr>
<td></td>
<td>Methanol</td>
</tr>
<tr>
<td>210–220 nm</td>
<td>n-Butyl alcohol</td>
</tr>
<tr>
<td></td>
<td>Isopropyl alcohol</td>
</tr>
<tr>
<td></td>
<td>Cyclohexane</td>
</tr>
<tr>
<td></td>
<td>Ethyl ether</td>
</tr>
<tr>
<td>245–260 nm</td>
<td>Chloroform</td>
</tr>
<tr>
<td></td>
<td>Ethyl acetate</td>
</tr>
<tr>
<td></td>
<td>Methyl formate</td>
</tr>
<tr>
<td>265–275 nm</td>
<td>Carbon tetrachloride</td>
</tr>
<tr>
<td></td>
<td>Dimethyl sulfoxide</td>
</tr>
<tr>
<td></td>
<td>Dimethyl formamide</td>
</tr>
<tr>
<td></td>
<td>Acetic acid</td>
</tr>
<tr>
<td>280–290 nm</td>
<td>Benzene</td>
</tr>
<tr>
<td></td>
<td>Toluene</td>
</tr>
<tr>
<td></td>
<td>m-Xylene</td>
</tr>
<tr>
<td>Above 300 nm</td>
<td>Pyridine</td>
</tr>
<tr>
<td></td>
<td>Acetone</td>
</tr>
<tr>
<td></td>
<td>Carbon disulfide</td>
</tr>
</tbody>
</table>
Many of the solvents in Table 2 are hazardous. Be sure you fully understand their properties before using them.

When using volatile solvents such as acetone or methylene chloride, make sure that the sample cell is stoppered. Evaporation of a solvent can change the solute concentration or cause solution noise due to solute convection currents. Both of these will affect the accuracy of your measurements. We also recommend stirring and temperature control when you use volatile solvents.

When using water as solvent we recommend using UV grade or HPLC grade water to reduce unwanted absorbance from the water. If you are using the sipper/sampler system the water should be degassed to avoid bubble formation in the flow cell, especially if the water comes from a pressurized water supply.

Sample Preparation

The sample cell should be rinsed three to five times with your intended solvent before you fill it with the pure solvent that will be used in the measurement. Turning the cell upside down on a small stack of absorbent tissues will help remove any residual solvent. This treatment will minimize contamination from previous experiments.

Samples which contain colloidal dispersions, dust or other particulate matter should be filtered, centrifuged or allowed to settle. If not, the overall attenuation-of-transmittance spectrum due to light scattering and/or reflection will hide the spectral information from the analyte.
Photosensitive Samples

A few substances are very photosensitive. They degrade or undergo photochemical reactions if exposed to light. This can be easily seen by a decrease of sample absorbance over time.

Use of Filters

The shorter wavelength, higher-energy UV light is most likely to degrade photosensitive samples. If you have a problem, you can selectively block portions of the UV spectrum with a UV cut-off filter. An optical filter wheel assembly with three cut-off filters is available for the spectrophotometer. The cut-off wavelength of the filter you choose should be low enough that it does not eliminate important spectral information but high enough that it blocks the light that could degrade your sample. If you use a filter with your samples, you must use the same filter when you make your blank measurement.

Turning the D2-Lamp off

The short wavelength radiation leading to photodegradation comes from the light of the D2-Lamp. For application where readings are taken at wavelengths above 400 nm, the D2-Lamp can be turned off. The light intensity supplied by the Tungsten lamp is sufficient for a good signal to noise ratio over the wavelength range 400 nm - 1100 nm. When using cells with small apertures, check the signal to noise ratio by making sample measurements under conditions of your application.

Stirring and Temperature Control

Solution homogeneity can be a problem, especially for viscous solutions. There are cases where, due to convection induced gradients, rapid absorbance changes may give irreproducible data. These changes can be observed spectroscopically by taking measurements with short integration times. To minimize convection effects keep the temperature of your sample the same as the cell holder or environmental temperature. Problems like these can also be minimized by using a thermostatable cell holder and/or a stirring module.

A similar effect can occur in cases of incomplete mixing. This is especially true where the specific gravities or miscibilities of the solvent and analyte are quite different. Again, stirring is a way to prevent this kind of problem.
In an unstirred cell, it is sometimes possible to observe local photodegradation of sensitive analytes. Because the actual volume of the sample in the light path is very small, stirring the sample will reduce the time any given analyte molecule is in the light path. This minimizes the photodegradation and increases homogeneity. Using a flow cell with continuous flow can yield similar results.

Checklist for Best Results

Cell:

✔ Cell is made of quartz or glass
✔ Apertured cells have black sides
✔ Apertured cells have an aperture greater than or equal to 3 mm
✔ Cell windows are free of fingerprints and other contamination
✔ Flow cell used instead of an apertured standard cell

Measurements:

✔ Solution in cell is free of floating particles
✔ Both solution in cell, and cell walls are free of bubbles
✔ Solution in cell is mixed homogeneously
✔ Blank measured on same solvent as sample
✔ Blank measurement shows a flat baseline (Figure 10 and Figure 11 show a good and a poor baseline)
✔ Cell orientation of blank and sample measurements is the same
✔ Ideally, the cell is not removed between the measurement, which means the cell is filled/rinsed using a pipette or a flow cell is used
✔ Time between blank and sample measurement should be short
Good Measurement Practices

General Considerations

Figure 10  Example of a blank on water showing a good baseline

Figure 11  Example of a blank on water with bubbles causing a poor baseline

NOTE  If your blank or spectra show artifacts similar to the one in Figure 11, see “Solvents” on page 39 to optimize the measurement procedure.
Inserting a Cell

Your spectrophotometer is shipped with the standard single-cell cell holder you must first install in the sample compartment. This cell holder accommodates standard cells or flow cells. To insert a sample cell (cuvette) in the cell holder:

1 Move the locking lever to its up position.

2 Insert the sample cell, making sure you orient it correctly. The frosted (non-clear) sides of the sample cell should not be in the path of the light beam.

3 Lock the sample cell in place by pushing the locking lever back down.

Small volume flow cells and particularly any cells with less than a 2 mm aperture may require use of the optional adjustable cell holder. The adjustable cell holder helps you ensure the cells are properly centered in the light path.
Many simple, mechanical/optical accessories are available to expand the capabilities of your UV-Visible spectrophotometer. This section briefly describes these accessories and outlines how to install them.

The following more complex accessories with electronic components are available to enhance the functionality and capabilities of your spectrophotometer. Information about these are included with the accessories in separate handbooks.

- Sipper system
- Autosampler
- Multicell transport
- Peltier temperature control accessory
The Agilent 89054A thermostattable cell holder (see Figure 12) is a single-cell cell holder with a manifold around the cell. Water from a thermostatted water bath can be circulated through the manifold to hold the sample cell at a uniform temperature. Up to 1 cm open-topped cells and flow cells can be used in a thermostattable cell holder.

![Figure 12 Thermostattable cell holder](image.png)
Installing a Thermostatable Cell Holder

1. Loosen the hold-down screws and remove the current sample holder from the sample compartment.

2. Orient the thermostatable cell holder the same way the standard cell holder was oriented and lower it onto the sample compartment mounting guides.

3. Tighten the hold-down screws.

4. Connect tubing (silicon, 3/16 inch i.d.) to the inlet and outlet of the manifold. It does not matter which side is used as the inlet and which side is used as the outlet. If necessary, route the tubing under the tubing restraint tab to keep it from interfering with the light beam. Make sure the tubing is securely attached; it expands when heated and if it is not secure, a leak will result.

5. Insert the sample cell and lower the lever down to lock the cell in place.

6. Begin pumping thermostatted water through the manifold. Wait for the sample cell and sample to reach thermal equilibrium before you make any measurements. The time required to reach thermal equilibrium will vary depending on the water temperature and the sample but generally should take about five minutes.

When the thermostatable cell holder is not in use, it is best to disconnect the tubing and drain the manifold.
4 Installing Accessories
Cell Stirring Module

Cell Stirring Module

The Agilent 89055A cell stirring module shown in Figure 13, mounts inside the base of the thermostattable cell holder. It enables magnetic induction stirring inside a standard 1 cm sample cell. The cell stirring module contains a plastic-encased magnetic impeller that can be driven by water or pressurized air. When you put a magnetic stirring bar (9301-1161) into the filled sample cell, the stirring bar rotates in tandem with the impeller magnet, thus stirring the sample.

Figure 13   Cell stirring module
Installing the Cell Stirring Module

1. Remove the thermostatable cell holder from the sample compartment.
2. Remove the three screws that hold the thermostatable cell holder to its base. Remove the cell holder and turn it upside-down.
3. Insert the cell stirring module into the cavity in the base of the thermostatable cell holder, see Figure 14.
4. Tighten the four screws (flathead, M3×6 mm) that hold the cell stirring module in place.
5. Attach the thermostatable cell holder to its base.
6. Mount the thermostatable cell holder back in the sample compartment.
Tubing Connections and Operation

The cell stirring module can be driven by either water or air. Water is preferable because it is more easily controlled. Water temperature can be up to 100 °C (212 °F) with a maximum allowable back pressure of 4 bar (approximately 60 psi). If air is used to drive the cell stirring module, the pressure should be less than 0.3 bar (approximately 5 psi) when the stirrer is started. Again, the maximum pressure is 4 bar (approximately 60 psi).

There are several ways you can connect a water or air supply to the cell stirring module, see Figure 15. In all cases we recommend using 3/16 inch i.d. silicon tubing between the water supply and the stirring module.

- The stirring module can be used alone, without the thermostattable functions of the cell holder.
- The same water supply can be used to regulate sample cell temperature and to power the cell stirring module.
If you need a faster stirring speed than can be obtained by connecting the manifold and cell stirring module in series, you can connect separate supplies to the manifold and stirring module.

![Diagram of cell stirring module connections](image)

**Figure 15** Tubing connections for a cell stirring module

**Table 3** Tubing connections for a cell stirring module

<table>
<thead>
<tr>
<th>Connection</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>A (in), B (out)</td>
<td>Without stirring</td>
</tr>
<tr>
<td>C (in), D (out)</td>
<td>Without cell thermostatting</td>
</tr>
<tr>
<td>A (in), B to D, C (out)</td>
<td>In series with cell thermostatting</td>
</tr>
<tr>
<td>A and C (in), B and D (out)</td>
<td>In parallel with cell thermostatting</td>
</tr>
</tbody>
</table>
Long Path Cell Holder

The Agilent 89076A long path cell holder is a sample cell holder which can be adjusted to hold most cylindrical and rectangular sample cells with path lengths of up to ten centimeters. It uses the same mounting system as the other sample cell holders.

The long path cell holder includes built-in cell stops for accurate positioning of 1, 2, 5, and 10-cm sample cells.

The optical filter wheel (08451-60302) can be mounted on the long path cell holder in the same way it is mounted on other cell holders, see “Optical Filter Wheel” on page 55 for details. However, instead of a screwdriver, a 2.5-mm hex wrench is required to install the optical filter wheel on the long path cell holder.
Installing the Long Path Cell Holder

1. Loosen the hold-down screws and remove the current sample holder from the sample compartment.
2. Orient the long path cell holder so that the clamps that hold the sample cell in place are on the right. Lower the cell holder onto the sample compartment mounting guides.
3. Tighten the hold-down screws.

Installing a Sample Cell

1. Position the cell stops according to the path length of the sample cell you will be using. This example shows a 1-cm sample cell:

![Diagram of cell stops and clamps](#)

**Figure 17** Positioning the cell stops for a 1-cm sample cell
If your sample cell is not one of the standard lengths, position the cell stops as for a long path sample cell, i.e. move all cell stops in Figure 17 to the left. Because the light beam is collimated, absolute positioning of the sample cell is not important; however, consistent cell positioning gives more consistent results. The cell stops make it easier to consistently position your sample cells.

Install the sample cell between the clamps. Slide it against the cell stop. If your sample cell is not one of the standard lengths, position it so the clamps are gripping the mid-point of the cell.

Allow the clamps to close against the sample cell, see Figure 18. Tighten the four screws that hold the sample cell in place.

Figure 18  Installed 10-cm cylindrical cell in the long path cell holder
Optical Filter Wheel

To achieve optimum measurement conditions, optical filters may be necessary for spectral measurements of photosensitive samples. Agilent Technologies offers an optical filter wheel assembly (08451-60302), see Figure 19, which can be mounted on the standard cell holder, the adjustable cell holder or the thermostattable cell holder. An optical filter wheel with the same filters but with a different mounting can be used with the multicell transport, see the multicell transport User’s Guide.

![Optical filter wheel assembly](image)

**Figure 19** Optical filter wheel assembly

The filter wheel rotates to four different positions. Position zero is empty and permits 100% transmittance at all light wavelengths. Positions one, two and three have filters which absorb varying amounts of the UV spectrum. Figure 20 shows the transmission characteristics of each filter.
4 Installing Accessories

Optical Filter Wheel

The choice of when to use a filter and which filter to use should be made only after considering all the factors that affect your measurements. If you decide that a filter is needed, you should choose a filter that transmits the wavelengths needed for analytical information and that blocks the wavelengths that contribute to sample degradation. Often, your final choice will be a compromise since sometimes even the light at the wavelengths of analytical interest can affect your sample.

If you do not need a filter for a group of measurements, you can move the filter wheel to position zero. This permits full light transmission. When you will not be using the filter wheel for an extended period of time you should remove the filter wheel assembly from the cell holder and store it in a clean plastic bag.

The optical filters of the filter wheel must be kept clean. Dirty filters interfere with light transmission and lower the spectrophotometer performance. These filters may be cleaned with isopropanol and photographic lens tissues.

![Figure 20](transmission.png)

**Figure 20** Transmission characteristics of filter wheel filters

**Table 4** Filter wheel positions

<table>
<thead>
<tr>
<th>Position</th>
<th>Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>1</td>
<td>UV roll-off</td>
</tr>
<tr>
<td>2</td>
<td>265 nm UV cut-off (at 50%T)</td>
</tr>
<tr>
<td>3</td>
<td>295 nm UV cut-off (at 50%T)</td>
</tr>
</tbody>
</table>
Installing the Filter Wheel Assembly

Installing the filter wheel assembly is fairly simple. The procedure is the same for all three cell holders. You will need a Phillips screwdriver to install the filter wheel assembly. However, if you install the filter wheel on the long path cell holder, instead of a screwdriver, a 2.5-mm hex wrench is required.

1. Remove the cell holder from the sample compartment.
2. Remove the two screws shown in Figure 21.
3. Position the filter wheel assembly clamp as shown in Figure 21. Replace the two screws but do not tighten them.

4. Tilt the outer edge of the clamp up slightly.
5. Bring the filter wheel assembly against the cell holder so that the clamp fits in the slot of the filter wheel assembly. The mounting ridges on the filter wheel assembly should fit into the holes in the clamp. The base of the filter wheel assembly should be against the base of the cell holder.
6. Tighten the screws that hold the clamp.

Figure 21  Installing the optical filter wheel assembly
Removing the Filter Wheel Assembly

1. Loosen but do not remove the two screws that hold the clamp.
2. Separate the filter wheel assembly from the cell holder.
3. The filter wheel clamp may be left in place or removed. In either case, retighten the two screws.
4. Store the filter wheel in a clean plastic bag.
5

Installing the UV-Visible Software

Agilent ChemStation Computer Details  60
Installing the Agilent ChemStation Using the DVD  63

This chapter describes the minimum hardware and software requirements and describes the installation process for the UV-Visible software.

It is assumed that a supported Microsoft Windows operating system is already installed.
Agilent ChemStation Computer Details

This section describes the PC hardware and operating system requirements that must be met for successful installation and operation of Agilent UV-Visible ChemStation.

Agilent UV-Visible ChemStation is supported on personal computers with a 3 GHz 64-bit (x86) processor or better. All PC hardware and peripherals must be listed in the Microsoft Windows Marketplace Tested Products List Hardware section. The hardware testing status is available from the Microsoft home page on the world wide web: (http://winqual.microsoft.com/HCL/Default.aspx). If your PC hardware is not tested, we cannot guarantee that the system will work with the supported operating system.

**NOTE**

The software will run with the minimum amount of RAM installed, but system performance will depend on what other processes are running.

### Minimum PC Requirements for Agilent ChemStation

**Table 5**  
Minimum PC Requirements

| PC configuration     | Windows 7 Professional 64-bit (SP1)  
<table>
<thead>
<tr>
<th></th>
<th>Windows 10 Professional 64-bit</th>
</tr>
</thead>
</table>
| Graphics resolution  | The recommended graphics resolutions for video graphics adapter are:  
|                      | 1024 x 768 with large fonts or  
|                      | 1280 x 1024 with large fonts        |
| Processor            | 3 GHz                                |
| Screen resolution    | Super VGA (1280 × 1024)              |
Scheduled Processes

Some scheduled processes, like virus checking or defragmenting, may cause instrument communication problems. Due to these problems, any automated measurement will be aborted. To prevent problems of this kind please disable any scheduled event.

Number Format

To avoid wrong values displayed or printed, the International settings must include the correct number format. Set the Number Format Decimal Separator to "." (decimal point) in Control Panel > Region and Settings.

Table 5  Minimum PC Requirements (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass storage</td>
<td>40 GB Hard-Disk and CD-ROM</td>
</tr>
<tr>
<td>Memory</td>
<td>Minimum of 4 GB of RAM for UV-Visible ChemStation software and a single instrument. The minimum recommended amount of memory for a single-bath dissolution system (G1118AA) and kinetic measurements (G1117AA) is 3 GB of RAM. Add 256 MB of RAM for each additional bath in a multi-bath dissolution system (G1118AA). In all cases, an appropriate amount of virtual memory should be configured.</td>
</tr>
</tbody>
</table>

NOTE

A maximum of four instruments may be interfaced to each Agilent ChemStation.

NOTE

If you are upgrading from a previous version of Agilent ChemStation, you must uninstall the old version of ChemStation first.
5 Installing the UV-Visible Software
Agilent ChemStation Computer Details

Printer

Logon to the PC with the ChemStationSystemUser account and then make sure that a default printer is configured in your Microsoft Windows operating system. This is done via the Control Panel application.

If no default printer is configured, you may encounter the following problems:
  • the 'Copy To Clipboard' menu may have an error
  • in the 'Custom Report View' there may be problems with new templates
  • the 'Print Preview' will not work
Installing the Agilent ChemStation Using the DVD

Overview

This section explains how to use the Agilent Technologies UV-Visible ChemStation Software Products DVD to:

• install the Agilent ChemStation for the first time
• upgrade/repair an existing Agilent ChemStation software
• install an additional Agilent ChemStation module

NOTE

Local Administrator rights on the target PC are required to perform the installation.

Uninstalling Pre-existing Agilent UV-Visible ChemStation Software

To remove all analytical ChemStation software from your hard disk for versions B.05.02 and earlier:

1. Insert your Agilent Technologies UV-Visible ChemStation Software DVD into the drive.
2. Run the setup program on the DVD.
3. Select Remove and then click Next.

Note that the removal of ChemStation software can also be done from within the Control Panel.

To remove all analytical ChemStation software from your hard disk for version B.05.03 ensure the following conditions are met and then follow the procedure above to uninstall the software.

1. Be logged in as a local administrator such as ChemStationSystem.
2. Have Full Control access to the following:
   • C:\Chem32
   • C:\Chem32\core
Installing the UV-Visible Software

Installing the Agilent ChemStation Using the DVD

- C:\Chem32\u vexe
- C:\Chem32\1
- C:\Chem32\2
- C:\Chem32\3
- C:\Chem32\4
- C:\Chem32\TMP
- C:\Chem32\NonInst
- C:\Chem32\ChemStation.ini

NOTE

Only files installed by the product DVD are removed. All additional files such as method and data files are not automatically removed. By default they are located in the respective instrument directory C:\Chem32\1.

NOTE

If the Security Pack had been installed, please see your manual Agilent ChemStation Security Pack for UV-Visible Spectroscopy - User’s Guide for details.

During the installation some of your configuration files will be changed. If you don't intend to use any ChemStation software you can remove the ChemStation.ini file located in the operating system folder, C:\Windows by default.

Installation Procedure

Use the following procedure if you are using the DVD to install or upgrade the Agilent ChemStation software.

Before installing the software:
- Set up the computer hardware.
- To connect your Spectrophotometer via LAN to the Computer see Chapter 6, “LAN Communication, Installation, Connection and Configuration”
• Make sure an operating system, supported by your revision of the Agilent UV-Visible ChemStation software, is available on the target PC.

If ChemStation is already installed and you are only adding a new module (also called an Add-on), you must ensure the following conditions are met before following the procedure below. If you are installing ChemStation and all modules at the same time, skip to the installation procedure.

**Prerequisites to Install a New Module to Existing ChemStation Software**

1. Be logged in as a local administrator such as *ChemStationSystem*.
2. Have Full Control access to the following:
   - C:\Chem32
   - C:\Chem32\core
   - C:\Chem32\uveexe
   - C:\Chem32\1
   - C:\Chem32\2
   - C:\Chem32\3
   - C:\Chem32\4
   - C:\Chem32\TMP
   - C:\Chem32\NonInst
   - C:\Chem32\ChemStation.ini

**Installing or Upgrading ChemStation**

1. Insert the Agilent UV-Visible ChemStation Products DVD into the DVD drive.
2. Click the Search or Cortana icon in the Windows 10 taskbar or Windows 7 Start menu. Type “Run”. Select **Run**.
3. At the command line, type `diskdrive:\Setup.exe` (for example, D:\Setup.exe), then click **OK**.
Installing the UV-Visible Software
Installing the Agilent ChemStation Using the DVD

4 Read the licence agreement and click Yes to accept.
5 Accept the default installation path C:\Chem32, then click Next.

**NOTE**
Agilent ChemStation must be installed in the default location C:\Chem32 directory.

6 Select the additional modules you want to install and click Next.

![Select Features](image)

Note that the Security-Pack Add-On and the ECM Add-On are mutually exclusive. One or the other can be installed, but not both.
7 Enter the License Registration Number for each selected module in the entry line and click Add License. When all required licenses are added, press NEXT.

![License Registration Screen](image)

The applicable product and license numbers are printed on your Software Certificate and Registration Packet (see the example license registration label).

![Software Registration Label](image)

**Figure 22** Example license registration label

8 The configuration editor will open automatically as part of setup. Adjust the configuration if desired. Save the configuration and exit the configuration editor. Setup will then continue.

**NOTE**

Editing the instrument configuration in the Configuration Editor must be performed by a user logged onto the client PC as the administrator account, *ChemStationSystem*. 

---

*Agilent Cary 8454 UV-Visible Spectroscopy System Installation Guide*
Installing the UV-Visible Software

9  Click **Finish** to complete the setup and reboot your system.

**NOTE**

Restarting your system is required before you proceed.

**NOTE**

If you selected the G3770AA or G5182AA ECM access module, establish your ECM access using Internet Explorer before you first launch UV-Visible ChemStation.

**NOTE**

During installation an administrator account *ChemStationSystem* is added to the PC. This administrator is created with a default password: ChemStation11System. If this password does not meet the current password policy requirements then the installation will fail. To proceed, temporarily turn off password requirements on the PC until the installation has successfully completed and then change the *ChemStationSystem* password as required.

**Administration of the ChemStationSystem Administrator Account**

Administration of the ChemStation administrator (*ChemStationSystem*) includes the following activities when the workstation is a PC on a domain:

1  Create a domain user named *ChemStationSystem* and make this user a local administrator.

2  Give (NTFS-Permission) Full Control for *ChemStationSystem* on the following directories and files (see below for instructions):

   - C:\Chem32
   - C:\Chem32\core
   - C:\Chem32\uvuexe
   - C:\Chem32\1
   - C:\Chem32\2
   - C:\Chem32\3
   - C:\Chem32\4
   - C:\Chem32\TMP
   - C:\Chem32\NonInst
   - C:\Windows\ChemStation.ini

**NOTE**

Restarting your system is required before you proceed.

**NOTE**

If you selected the G3770AA or G5182AA ECM access module, establish your ECM access using Internet Explorer before you first launch UV-Visible ChemStation.

**NOTE**

During installation an administrator account *ChemStationSystem* is added to the PC. This administrator is created with a default password: ChemStation11System. If this password does not meet the current password policy requirements then the installation will fail. To proceed, temporarily turn off password requirements on the PC until the installation has successfully completed and then change the *ChemStationSystem* password as required.
3 Run “ChemStation System Configuration” from the Start Menu.

4 In the Save UV-Vis ChemStation System User Password window, enter and confirm the Microsoft Windows password for the ChemStationSystem account and then click on Save. For a local installation the domain listed should be the computer name.

![Save UV-Vis ChemStation System User Password](image)

**Figure 23** Save UV-Vis ChemStation System Configuration changes

If these details are not correct, you will not be able to start ChemStation.

---

5 Ensure that the dialog “User Configuration Saved” is shown.

6 Log out of Microsoft Windows.

7 Log into the ChemStationSystem account. Set up any printers that are to be used with the UV-Visible ChemStation while on this account. Log out when finished.
Designating Folder Permissions when Creating a Domain ChemStation User

1. Right click on the file/folder and then select Properties.
2 Select the Security Tab and then click **Edit**.

![Figure 25 Opening the Edit Security dialog](image)

3 Click **Add**.

4 Make sure the location is the PC, and type *ChemStationSystem* in the object name field, click **OK** and click **OK** again.

![Figure 26 Entering the object name](image)
Installing the UV-Visible Software

Installing the Agilent ChemStation Using the DVD

5 Highlight the ChemStationSystem domain user that was just added and then select Full Control and click OK.
6 Repeat this for all of the folders described in the section above.

Configuring Your System

The setup program configures the system automatically for your UV-Visible spectrophotometer as Instrument 1, with an GPIB address of 25.

If you wish to use LAN communication, set up an additional spectrophotometer, or set up an temperature control accessory you must configure the system.

To configure your system:

1 In the Agilent ChemStation group start the Agilent UV-Visible Configuration Editor.
2 Choose Instruments from the Configure menu.
   • The Instrument Type box lists the instrument types available on your Agilent ChemStation. Select one to begin your configuration.
   • Enter the name you want to call the instrument in the Instrument Name box. The Agilent ChemStation will use this name to identify the instrument.
   • Select Normal under Initial Screen Window Size to have your instrument session window appear as a full screen but with an open area across the bottom for icons. If you select Icon or Full Screen, the instrument session window will start as an icon or as a full screen.
   • Click OK to enter your selections and to display the Instrument Name - Device Configuration.
   • To modify settings in an existing instrument configuration, you must select the module first in the Selected Modules frame and press the Delete button.
   • Select the module in the Modules frame and chose the type of interfacing.
   • In case of a LAN connection, select the LAN option and press Add. In the upcoming dialog select Identify by Host Name or Identify by IP Address and enter the selected information - Host Name: or IP Address: - in the entry field. Press OK to add the module to the list of Selected Modules.
• Click **OK** to complete the instrument configuration.

If you configure more than one instrument, you must ensure that each instrument has a unique LAN address. You can configure up to four spectrophotometers.

3 Click OK to enter your selections and to return to the main menu.

4 If you want to change the color of a screen element:

Choose **Colors** from the Configuration menu, select that element under Screen Elements, then select a color from those shown below in the Standard Colors or Custom Colors list box. Your changes will appear in the Screen Elements list box. You can create custom colors and add these, use the **Add Custom Colors...** button and follow the instructions available with the **Help**.

5 If you want to add new instruments:

Choose **Add New Instrument** from the Add/Delete menu to add a new instrument window to the Configuration Editor screen. Follow the above procedure to configure the instrument. Choose **Delete Instrument** from the Add/Delete menu to remove an instrument from the configuration.

6 Choose **Save** from the File menu to save your configuration.

7 Choose **Exit** from the File menu to close the Configuration Editor.

8 To set parameters for the accessories you have installed and configured, refer to the Help in the UV-Visible ChemStation software.

**Autosamplers**

If you have an Agilent XY autosampler, your Agilent ChemStation software requires a special driver and a cable. See the readme.txt for further information.
5 Installing the UV-Visible Software

Installing the Agilent ChemStation Using the DVD
6 LAN Communication, Installation, Connection and Configuration

Installing and Configuring TCP/IP on the PC  76
Installing the LAN Interface in your UV-Visible Spectrophotometer  79
Connecting the Spectrophotometer to the PC  80
Using the Agilent BootP Service  82
Using the Agilent ChemStation Configuration Editor to Configure the Spectrophotometer  91
Troubleshooting LAN Communication  94

The first five sections of this chapter describe all necessary installations, connections and configurations of the LAN communication.

The last section of this chapter helps you if the LAN communication does not work properly.
Installing and Configuring TCP/IP on the PC

Installation of the TCP/IP protocol

1. For Windows 7, select Start > Control Panel > Network and Sharing Center. For Windows 10, right-click on Start and then select Control Panel > Network and Internet > Network and Sharing Center.

2. In the Tasks list click on Manage network connections. In the LAN or High-Speed Internet list right click on your LAN adapter icon and select Properties.

![Local Area Connection Properties](image)

**Figure 27** Local Area Connection Properties
3 In the ‘Local Area Connection Properties’ dialog (see Figure 27) click Configure... to make sure the device is working properly.

NOTE If the device is not working properly or no network interface card is configured, please refer to the hardware manual of your network card and the PC for how to install and configure a network interface card.

4 In the ‘This connection uses the following items:’ section of this dialog make sure the ‘Internet Protocol Version 4(TCP/IPv4)’ is available and checked.

NOTE If the TCP/IP protocol is not installed, use the Install button, select Protocol from the list of network components to install and press Add. From the ‘Manufacturers:’ select ‘Microsoft’ and from the ‘Network Protocol:’ select the ‘Internet Protocol Version 4(TCP/IPv4)’ and press ‘OK’. If required, reboot your computer.


NOTE If the PC is connected to your companies LAN, do not change any setting. Note down the ‘Subnet Mask’ if available. Ask your responsible IT consultant for this mask if not available and request a fixed IP address for your instrument, if you want to use the existing LAN for the instrument connection.

For further details please see“Connecting the Spectrophotometer to the PC”.
6 LAN Communication, Installation, Connection and Configuration
Installing and Configuring TCP/IP on the PC

In the ‘Internet Protocol Version 4 (TCP/IPv4) Properties’ dialog (see Figure 28) select the option **Use the following IP address** and enter your computer’s **IP Address** and **Subnet Mask**.

- If the system is on an isolated LAN, the following defaults can be used: 192.168.254.10 for the PC IP address, and 255.255.255.0 for the subnet mask. (note: to use these defaults, DIP switches 5 and 6 on the LAN card must be "ON”).

**NOTE**

Gateway, DNS and WINS IP addresses do not need to be configured if you do not connect to any other part of a network.

7 Turn off the Microsoft Windows Firewall and reboot the computer.
Installing the LAN Interface in your UV-Visible Spectrophotometer

The JetDirect card (G1846A) and the TalkToLab card (G1369C) are the LAN interfaces used to physically connect the spectrophotometer to the PC via a LAN cable. To install the LAN interface card:

1. Switch off the spectrophotometer.
2. Remove the metal cover at the upper right of the rear panel.
3. If the system is on an isolated LAN, the following defaults can be used: 192.168.254.10 for the PC IP address, 255.255.255.0 for the subnet mask, and 192.168.254.11 for the spectrophotometer. (note: to use these defaults, DIP switches 5 and 6 on the LAN card must be "ON").
4. Plug the LAN interface card into the slot and screw down the two mounting screws.
Connecting the Spectrophotometer to the PC

This section describes how to setup the connection between your instrument(s), and the PC. If you are going to connect to an existing LAN, please contact your system administrator for further assistance.

**Single Instrument Installation**

In a single instrument installation, only one UV-Visible spectrophotometer is connected to the PC’s LAN interface. In this configuration, only the black 10 ft. long crossover twisted pair cable (part number 5183-4649) can be used. This is supplied with the Agilent UV-Visible ChemStation software.

**NOTE**

Do not use the standard (non-crossover) Ethertwist 10BaseT cable supplied with the LAN interface card G1846A for direct single instrument connection.

**Multiple Instrument Installation**

If you want to connect more than one spectrophotometer to the Agilent ChemStation PC or if the PC needs to connect to a network using the same network connection, a switch (for example the G2402A 8 port switch) is required. The G2402A switch comes with one standard EtherTwist 10BaseT cable that is used for the connection to the PC. Use the standard EtherTwist 10BaseT cable (part number G1530-61485) provided with the LAN interface cards to connect the switch to the spectrophotometer.

**NOTE**

Do not use the black 10 ft. long crossover twisted pair cable (part number 5183-4649) in an installation with multiple instruments.
Connecting the Spectrophotometer to the PC

Setting the IP Address of the Spectrophotometer

The IP address of the LAN interface card inserted to the spectrophotometer can be assigned by using the Agilent Bootp service. This service assigns the LAN interface card with a configured IP address, each time an IP address is requested. Refer to the next section “Using the Agilent BootP Service” on page 82.

**NOTE**

If the system is on an isolated LAN and the default IP address 192.168.254.11 for the spectrophotometer is used, BootP is not necessary.
Using the Agilent BootP Service

What is the Agilent BootP Service?

The Agilent Bootstrap Protocol Service, acronym BootP Service, provides central administration of IP addresses for Agilent instruments on a LAN. The service runs on the instrument LAN PC, which must be running TCP/IP network protocol and cannot run a DHCP server/service or another BootP Service.

When an instrument is powered on, an Agilent LAN interface card in the instrument broadcasts a request for an IP address or Host Name and provides its hardware address as an identifier. The request may continue for up to 5 minutes. The Agilent BootP Service answers this request and passes a previously defined IP address and Host Name associated with the hardware address to the requesting instrument.

In case of the instrument on the LAN, the G1369C LAN card used to connect the spectrophotometer to the LAN does not store any settings, so each time the instrument is powered on the card sends a request to the network for an IP address and setting information. The implementation of the BootP protocol on the G1369C LAN card conforms to RFC 951 and RFC 1048.

In order to provide this information to the card, the BootP Service must be operational before the card sends the request and the BootP Service must be configured to know the hardware address (also called Media Access Control, acronym MAC address) of the LAN interface card. Multiple LAN interface cards can be configured by means of a single BootP Service.

If your network is already using a BootP Service, please refer to section “Configuring the G1369C LAN Card Using BootP” on page 89. If you do not have a BootP Service, we suggest to use the Agilent BootP Service program supplied on the Agilent UV-Visible ChemStation DVD.
## Addresses

Before installing and configuring BootP Service, you must know the IP addresses of the computer and instruments, the subnet mask, and the gateway.

### Table 6  Example

<table>
<thead>
<tr>
<th>Device</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>10.10.10.1</td>
</tr>
<tr>
<td>Spectrophotometer</td>
<td>10.10.10.101</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>Gateway</td>
<td>10.10.10.1</td>
</tr>
</tbody>
</table>
Using the Agilent BootP Service Program

The Agilent BootP Service program allows configuring the LAN interface card. Within the Launch Manager of the program you can easily add a MAC address and IP address pair to the configuration. The Launch Manager is displaying a list of the currently configured MAC address and allows modification of the current configured settings.

![BootP Manager interface](image)

**Figure 30** Configured interfaces view of the Agilent BootP Service
Configure the Agilent BootP Service Program

NOTE
If the system is on an isolated LAN and the default IP address 192.168.254.11 for the spectrophotometer is used, BootP is not necessary.

Before configuring BootP Service, you must know the IP addresses of the computer and instruments, the subnet mask, and the gateway. The MAC or hardware address of a LAN interface is a world wide unique identifier. No other network device will have the same MAC address. The MAC address is printed on the card or can be read out during the configuration procedure:

NOTE
If the PC has been rebooted after installing the Agilent BootP Service, the Agilent BootP Service is started automatically during the next startup of the system. To change BootP settings, the service must be stopped, the changes made, then restarted. The details are documented within this section.

Determine your MAC Address

Determine the MAC address of the LAN card installed. The number is engraved in the board.

Write down the MAC address before installing the card into the module. To remove the card from the system, turn the module off before removing the LAN card. Read the MAC address from the label. Reinstall the card and turn on the module again.
Using the Launch Manager

1. To add the instrument to the network go to Start > All Programs or All Apps > Agilent BootP Service > Edit BootP Settings. The BootP Settings screen appears.

2. Uncheck Do you want to log BootP requests?

3. Click Launch Manager. The BootP Manager screen appears.

4. Click Add.... The Add BootP Entry screen appears.

5. Make the following entries for your instrument:
   - MAC Address
   - Host Name
   - IP Address
   - Comment, if desired
   - Subnet Mask
   - Gateway Address

6. Click OK.

7. Exit Launch Manager and reboot both the PC and the spectrophotometer.

8. Ping the IP address from a command prompt on the PC to verify.
Configure the Agilent BootP Service

BootP Service starts automatically when your PC reboots. In order to add an additional instrument or to change the configuration the service must be stopped. After the changes have been applied, the service must be restarted.

1 To stop the BootP service:

For Windows 7: Start > Control Panel > System and Security > Administrative Tools >Services.

For Windows 10: Right-click on Start and then select Control Panel > System and Security > Administrative Tools > Services.

![Services window](image)

Figure 32 Services window

2 Right click Agilent BootP Service.

3 Select Stop.

4 Close the Services and Administrative Tools windows.

5 To edit the BootP Settings go to Start > All Programs or All Apps > Agilent BootP Service > Edit BootP Settings. The BootP Settings screen appears.
When this screen opens the first time, the default settings from installation are displayed.

6 To edit the TabFile, select **Maintain bootp tabfile?**
The default tab file was created at installation and is located at Program Files\Common Files\Agilent Shared\BootP\bin\TabFile. It contains configuration information entered on this screen.

If necessary you can
• change the BootP tab File Location by using the browse button on the right (a valid BootP tabfile must exist).
• create your own template for the tabfile by selecting **Create template BootP tabfile?** and click **Create Template**.

7 Select **Do you want to log bootp requests?**
The default log file was created at installation and is located at Program Files\Common Files\Agilent Shared\BootP\bin\LogFile. It contains an entry for every time a device requests configuration information from BootP.

If necessary you can change the BootP log File Location by using the browse button on the right (a valid BootP tabfile must exist).

8 Perform your necessary changes by e.g. creating a log file entry of a new instrument and edit the new instrument using the Launch Manager.

9 Deselect **Do you want to log bootp requests?**

10 Click **OK** to save the values or **Cancel** to discard them. The program ends.

11 To restart the BootP Service:

  For Windows 7: **Start > Control Panel > System and Security > Administrative Tools > Services**.

  For Windows 10: Right-click on **Start** and then select **Control Panel > System and Security > Administrative Tools > Services**.

12 Right click **Agilent BootP Service**.

13 Select **Start**.

14 Close the Services and Administrative Tools screen.

15 This completes the configuration.
Configuring the G1369C LAN Card Using BootP

In order for an internal G1369C LAN card to use BootP, the default setting: bootp=YES must be set. For more details please see the user manual of your G1369C LAN interface card.

To change the setting, the card must be reset; this is done each time the instrument with the G1369C LAN card inserted is power cycled.

The Agilent BootP Service uses a file called bootptab were all the configuration information is stored. The BootP Service program on the Agilent ChemStation CD-ROM allows easy editing of the bootptab file. If a BootP Service is already installed, the following information must be supplied to the system administrator to be able to correctly set up the bootptab file.

```sh
# CAG Bootptab file
# global defaults
global.defaults:
  sm=255.255.255.0:
  gw=<gateway address - ask your system administrator>

#8454 lab
UV-Vis:
  ht=1:
  ha=0030D30D3277:
  ip=<ip address - ask your system administrator>
  sm=255.255.255.0:
  gw=<gateway address - ask your system administrator>
  vm=auto:
  hn:
  bs=auto:
  T145=64:T146=01:T147=01
```
LAN Communication, Installation, Connection and Configuration

Using the Agilent BootP Service

The entries are described below

- **#8454 lab**
  Comment line starting the configuration set for an Agilent Cary 8454 UV-Visible spectrophotometer. A comment is preceded with #; all characters after the # on the same line are ignored by the BootP Service.

- **UV-Vis:**
  Host name of the instrument. The host name communication can only be used if a DNS server (Domain name server) is correctly set up for the name or a corresponding entry in the HOSTS file exists (windows\system32\drivers\etc\hosts).

- **ha=0030D30D3277:**
  This is the hardware or MAC address of the G1369C LAN card. It is usually printed on a label attached to the card. If not, see section “Determine your MAC Address” on page 85.

- **ip=<IP address - ask your system administrator>**
  This is the IP address that will be assigned to the card after the BootP request. This IP address must be configured using the Agilent ChemStation Configuration Editor.

- **sm=255.255.255.0:**
  This is the subnetmask assigned by the BootP request.

- **gw=<gateway address - ask your system administrator>**
  This is the gateway address assigned by the BootP request.

- **T145=64:T146=01:T147=01**
  These parameters configure the buffer handling of the G1369C LAN card. These are required for the instrument on the LAN to work properly and must not be changed.

Different entries for the subnet mask and default gateway might be required, depending on your network setup. These values need to be set by your network administrator.
Using the Agilent ChemStation Configuration Editor to Configure the Spectrophotometer

What is the Agilent ChemStation Configuration Editor?

The Agilent ChemStation Configuration Editor is a program that allows the easy configuration of your Agilent UV-Visible ChemStation software. This includes

- Selecting communication using LAN
- Configuring the analytical hardware connected to the PC.
- Configuring the paths used for data storage.
- Configuring color display of the Agilent ChemStation.

Since the Configuration Editor modifies the internal communication module database, the Agilent UV-Visible ChemStation must be closed beforehand.

NOTE

If LAN connection is used, Microsoft TCP/IP protocol must be installed and configured, the LAN interface Card must be installed, the spectrophotometer must be connected to the PC, and a bootp server must be installed and configured before the spectrophotometer(s) can be used. See “Installing and Configuring TCP/IP on the PC” on page 76 for details.
Configuring an Agilent Cary 8454 UV-Visible Spectrophotometer

This section describes how to configure an Agilent Cary 8454 UV-Visible spectrophotometer for LAN communication.

1. Start the Agilent ChemStation Configuration Editor by double-clicking on the Configuration Editor icon in the UV-Visible ChemStation start-up group, by choosing Start > All Programs or All Apps > UV-Visible ChemStations > UV-Vis Configuration Editor.

2. Select the Configure > Instruments menu option.

3. Select the Instrument Type UVVis, enter an Instrument Name for your configuration (e.g. 8454 UV-Visible System [1]), choose an Initial Screen Window Size, and click OK.

4. Select the Spectrophotometer 8454 in the Modules tab, select the LAN option, and click Add to add to the Selected Modules box.

5. Select Identify by IP Address and type in the IP address of the LAN interface card. (If a DNS server is installed you can also define the host name.)
6 Click **OK** to exit and to return to the Device Configuration dialog box, which now should look like this:

![Device configuration dialog (LAN interfacing)](image)

**Figure 34**  Device configuration dialog (LAN interfacing)

7 Click **OK** to exit the Device Configuration dialog box and save your configuration changes by selecting **File > Save**.

8 Exit the Configuration Editor by selecting **File > Exit**.

9 Reboot the PC and power cycle the instrument.

10 Wait until the front panel light on the instrument turns green. Then start the Agilent ChemStation to check if the software communicates with the spectrophotometer. In case the red error message line Power Fail shows up, refer either to the following troubleshooting section or repeat the installation procedure.
Power failure reported on the Agilent ChemStation

If your Agilent ChemStation can not connect to the spectrophotometer using LAN communication, please perform the following troubleshooting steps.

Verify that basic communication is possible

Use the ping command, to verify that the IP address is operational.

1. Click the Search or Cortana icon in the Windows 10 taskbar or Windows 7 Start menu. Type “Run”. Select Run.... In the Open: field type cmd.exe and then click OK.

2. Type ping <IP-number> and press Enter to verify communication of the LAN Interface Card and the LAN interface in your PC. <IP-number> needs to be replaced by the appropriate IP address (e.g. 10.10.10.101) or host name.

3. The command ping will send a request for reply to the IP address, bypassing part of the Windows TCP/IP settings. A successful ping would look like this:

   Reply from 10.10.10.101: bytes=32 time<10ms TTL=128

   If the message request timed out is displayed, the IP address can not be reached by the ping command.

4. If the ping request was answered successfully by the instrument, you need to verify that your Windows TCP/IP settings are correct for the selected network, especially the subnet mask and gateway settings should be checked.

Identify by host name

If you identify the UV-Visible system by host name, ensure that the used host name and IP address are correctly setup in the DNS server. Try using the IP address in the Configuration Editor.
Verify that the LAN Interface card is correctly configured

To ensure that all parameters of the LAN interface card are set correctly, use the Agilent BootP Service program from the Agilent UV-Visible ChemStation CD-ROM and disable any other means that configure the LAN interface card of the instrument. Install the bootp service as described in section “Using the Agilent BootP Service” on page 82 and configure it for the MAC address of the LAN interface card.

DHCP server

Make sure that no DHCP server runs in the same subnet as the instrument(s), as these servers also may respond to a bootp request and do not set the buffer handling of the LAN interface card correctly, i.e. T145=64:T146=01:T147=01. They also may assign a different IP address to the instrument each time it is started.

If a DHCP server is running in the same subnet, make sure that fixed IP addresses are reserved for your instruments. Ask your IT consultant to make sure that no IP address conflict may occur.

Frequent buffer overrun in Agilent Cary 8454 logbook

Please contact your system administrator, to check if the network is not capable of the network traffic induced due to the data acquisition of the instrument(s). This can also be caused by an incorrectly configured buffer handling of the LAN interface card (correct settings: T145=64:T146=01:T147=01).
Troubleshooting LAN Communication
A

Safety Information

Agilent products must only be used in the manner described in the Agilent product user guides. Any other use may result in damage to the product or personal injury. Agilent is not responsible for any damages caused, in whole or in part, by improper use of the products, unauthorized alterations, adjustments or modifications to the products, failure to comply with procedures in Agilent product user guides, or use of the products in violation of applicable laws, rules or regulations.

Protective Earth

**WARNING**

**Shock Hazard**

Connecting the Agilent Cary 8454 UV-Vis to a power source that is not equipped with a protective earth contact creates a shock hazard for the operator and can damage the instrument. Always operate your instrument from a power outlet which has a ground connection.

Disconnecting Device

**WARNING**

**Shock Hazard**

To disconnect the instrument from line power, disconnect the power cord from the supply. The power supply still uses some power and a shock hazard remains inside the instrument, even if the power switch on the front panel is turned off.

For safety reason do not position the equipment so that it is difficult to operate the disconnecting device.
A  Safety Information

UV Light Source

Eye Hazard

WARNING
Eye damage may result from directly viewing light produced by deuterium lamps. Always turn off the deuterium lamps before opening the lamp door on the instrument. Direct viewing of ultraviolet rays without protection causes permanent blindness or vision impairment.

Equipment Class

The Agilent Cary 8454 UV-Vis instrument is suitable for indoor use only and is classified suitable under Equipment class I category.

Installation category

The installation category is II, based on IEC61010-1. The installation category implies the regulation for impulse withstand voltage. It is also called the 'Over voltage category'. 'II' applies to electrical equipment with a nominal supply voltage up to 300 V.

Pollution level

The pollution level is 2, based on IEC61010-1. Pollution level describes the degree to which a solid, liquid or gas that deteriorates dielectric strength is adhering. '2' applies to a normal indoor atmosphere, where only non-conductive pollution occurs.
Index

A
accessory boards slot, 24
accurate results, 32
acetic acid, 39
acetone, 39
acetonitrile, 39
adding new instruments, 73
additional qualification, 30
air circulation, 19
air for cooling, 18
ambient stray light, 21
analytes, 32
apertured cells or cuvettes, 35
apertures, 41
automated self-test, 30

B
baseline noise, 30
benzene, 39
blank, 32, 42
blank pushbutton, 23
bootp server, 82
bubble formation, 40
buffer handling, 90

C
carbon disulfide, 39
carbon tetrachloride, 39
chloroform, 39
cleaning cells, 37
colloidal dispersions, 40
common solvents, 39
computer video socket, 26
configuration editor, 72, 92
connecting power to your spectrophotometer, 24
connecting tubing, 47
consumption (line power), 17
contents of shipping container, 20
cooling air, 18
cut-off filter, 41
cut-off wavelength, 41

cyclohexane, 39
cyclopentane, 39
degassed, 40
device configuration, 72
dimethyl formamide, 39
dimethyl sulfoxide, 39
dirty filters, 56
display, 26
dust, 40
degassed, 40
device configuration, 72
dimethyl formamide, 39
dimethyl sulfoxide, 39
dirty filters, 56
display, 26
dust, 40

electronic self tests, 28
entrapment of bubbles, 36
error condition, 22, 23
ethyl acetate, 39
ethyl ether, 39
excessive noise, 30
fan, 28
flow cell, 36
flow cells, 44
frequency (line power), 17
front panel indicator, 22
front panel pushbuttons, 23
front view, 21
fuses, 17

general purpose input/output connector, 24
glass cells, 33
glycerol, 39
GPIO connector, 24
ground connection, 18

H
handling cells, 38
hardware installing, 60
hardware address, 82, 85
highest precision measurements, 36
homogeneity, 42
host name, 90, 94
HPLC grade water, 40

I
indicator, 28
indicator on front panel, 22
Installation of the TCP/IP protocol, 76
installing hardware, 60
installing the waste tubing, 25
instrument icons, 30
instrument types in configuration editor, 83
isopropyl alcohol, 39

J
JetDirect card
spectrophotometer IP addresses, 81
### Index

**K**
- keyboard, 26

**L**
- lamp intensity, 29
- lamps start turning on, 28
- LAN, 79
  - LAN adapter
    - JetDirect card, 79
    - TalkToLab card, 79
- Lan Adapter, 79
- lens tissues, 37
- license registration number, 67
- light beam, 34, 37
- line frequency, 17
- line power consumption, 17
- line power input socket, 24
- line power supply, 17
- line power switch, 22
- line voltage, 17
- liquid samples, 32

**M**
- MAC address, 82, 85, 90
- magnetic impeller, 48
- magnetic induction stirring, 48
- making measurements, 32
- methanol, 39
- methyl formate, 39
- MIO board slot, 24
- mouse, 26
- multicell connector, 24
- m-xylene, 39

**N**
- n-butyl alcohol, 39
- n-hexane, 39

**O**
- offline mode, 30
- online mode, 30
- optical filter, 41
- optical self tests, 28
- optical specifications of cells, 34
- optical surfaces, 37

**P**
- parallelism, 34
- particulate matter, 40
- passivating new cells, 37
- photochemical reactions, 41
- photodegradation, 41
- photographic lens tissues, 56
- photosensitive substances, 41
- pipette, 38
- plastic sample cells, 33
- poor linearity, 35
- poor photometric accuracy, 35
- power consumption, 17
- power supply, 17
- power switch, 22
- printer cable, 26
- proper operating condition, 30
- pushbuttons, 23
- pyridine, 39

**Q**
- quartz sample cells, 33

**R**
- rapid absorbance changes, 41
- ready to measure, 28
- recommended cells, 35
- red blinking error condition, 23, 28
- red error condition, 22, 28
- remote connector, 24
- repeat ignition cycle, 28
- RS 232 connector, 24

**S**
- safety light switches, 24
- sample, 32, 42

**T**
- TalkToLab, 79
- temperature control, 40
- thermal equilibrium, 47
- thermostattable cell holder, 41
- thermostatted water, 47
- sample cell, 32, 40
- sample degradation, 56
- sample pushbutton, 23
- screen pushbutton, 23
- selftests, 22
- sensitivity, 35
thermostatted water bath, 46
toluene, 39
trimethylpentane
  2,2,4-trimethylpentane, 39
turn on your spectrophotometer, 27
turn-on self-test, 30

U
useful wavelength range of solvents, 39
UV grade water, 40

V
video socket on computer, 26
viscous solutions, 41
volatile solvents, 40
voltage (line power), 17

W
waste container, 25
water, 39
wedge shaped cells, 34
In This Book

This handbook describes the steps needed to install your new Agilent Cary 8454 UV-Visible spectroscopy system.

Most of the handbook deals with installing a complete system, that is, spectrophotometer, computer and printer. However, in the second half of this handbook you will find additional information about installing mechanical and optical accessories, accessory boards, GPIB connections and configuration, and software installation.